MoveWhenInTheWay Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproMoveWhenInTheWayC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproMoveWhenInTheWayX": 1} {ewc HLP95EN.DLL, DYNALINK, "Applies
To":"ofproMoveWhenInTheWayA"} {ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofproMoveWhenInTheWayS"}

True if the Office Assistant window automatically moves when it's in the way of the user's work area.
For example, the Assistant will move if it's in the way of dragging or dropping or in the way of
keystroke entries. Read/write Boolean.

Remarks

The MoveWheninTheWay property corresponds to the Move when in the way option under
Assistant capabilities on the Options tab in the Office Assistant dialog box.



MoveWhenInTheWay Property Example

This example displays the Office Assistant in a specific location, and it sets several options before
making the Assistant visible.

With Assistant
.Reduced = True
.Left = 400
.MoveWhenInTheWay = True
.TipOfDay = True
.Visible = True
.Animation = msoAnimGreeting
End With



NewBalloon Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproNewBalloonC"} {ewc HLP95EN.DLL, DYNALINK,

"Example":"ofproNewBalloonX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproNewBalloonA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproNewBalloonS"}

Creates a new Office Assistant balloon. Returns a Balloon object.



NewBalloon Property Example

This example creates a balloon with a heading, text, and three region choices, and then displays it.

With Assistant.NewBalloon
.Button = msoButtonSetOK

.Heading = "Regional Sales Data"
.Text = "Select a region"
For i = 1 To 3
.CheckBoxes (1) .Text = "Region " & 1
Next
.Show

End With



Reduced Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproReducedC"} {ewc HLP95EN.DLL, DYNALINK,

"Example":"ofproReducedX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproReducedA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproReducedS"}

True if the Office Assistant window appears in its smaller size. Read/write Boolean.



Reduced Property Example

This example displays the Office Assistant in a specific location, and it sets several options before
making the Assistant visible.

With Assistant

.Reduced = True

.Left = 400

.MoveWhenInTheWay = True

.TipOfDay = True

.Visible = True

.Animation = msoAnimationGreeting
End With



SearchWhenProgramming Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproSearchWhenProgrammingC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproSearchWhenProgrammingX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies
To":"ofproSearchWhenProgrammingA"} {ewc HLP95EN.DLL, DYNALINK,

"Specifics":"ofproSearchWhenProgrammingS"}

True if the Office Assistant displays application help as well as programming help while the user is
working in Visual Basic. Read/write Boolean.

Remarks

The SearchWhenProgramming property corresponds to the Search for both product and
programming help when programming option under Assistant capabilities on the Options tab in
the Office Assistant dialog box.



SearchWhenProgramming Property Example

This example enables you to search both application and programming help while you're working in
Visual Basic.

Assistant.SearchWhenProgramming = True



Show Method

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthShowC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthShowX": 1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofmthShowA"} {ewc
HLPO95EN.DLL, DYNALINK, "Specifics":"ofmthShowS"}

Balloon object: Displays the specified balloon object. Returns an msoBalloonType constant that
indicates which balloon the user clicks.

FileFind object: Displays the Find File dialog and the current search criteria. Macintosh only.

Syntax
expression.Show

expression Required. An expression that returns a Balloon object or a FileFind object.

Remarks

For the Balloon object, you can use the return value of the Show method to display a user's button
selection. The Show method returns one of the following msoBalloonType constants:

msoBalloonButtonAbort msoBalloonButtonBack
msoBalloonButtonCancel msoBalloonButtonClose
msoBalloonButtonignore msoBalloonButtonNext
msoBalloonButtonNo msoBalloonButtonNull
msoBalloonButtonOK msoBalloonButtonOptions
msoBalloonButtonRetry msoBalloonButtonSearch
msoBalloonButtonSnooze msoBalloonButtonTips

msoBalloonButtonYes msoBalloonButtonYesToAll



Show Method Example

This example creates a balloon containing three choices. The variable x is set to the return value of
the Show method, which will be 1, 2 or 3, corresponding to the label the user clicks. In the example, a
simple message box displays the value of the variable x, but you can pass the value to another
procedure, or you can use the value in a Select Case statement.

Set b = Assistant.NewBalloon

With b
.Heading = "This is my heading"
.Text = "Select one of these things:"
.Labels (1) .Text = "Choice One"
.Labels (2) .Text = "Choice Two"
.Labels (3) .Text = "Choice Three"
X = .Show

End With

MsgBox x



Sounds Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproSoundsC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproSoundsX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproSoundsA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproSoundsS"}

True if the Office Assistant produces the sounds that correspond to animations. Read/write Boolean.

Remarks

If a sound card is not installed, this property has no effect.



Sounds Property Example

This example displays the Office Assistant, animates it, and generates sound.

With Assistant

.Visible = True

.Sounds = True

.Animation = msoAnimationBeginSpeaking
End With



TipOfDay Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproTipOfDayC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproTipOfDayX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproTipOfDayA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproTipOfDayS"}

True if the Office Assistant displays a special tip each time the Office application is opened.
Read/write Boolean.
Remarks

The TipOfDay property corresponds to the Show the Tip of the Day at startup option under Other
tip options on the Options tab in the Office Assistant dialog box.



TipOfDay Property Example

This example displays the Office Assistant in a specific location, and it sets several options before
making the Assistant visible.

With Assistant
.Reduced = True
.Left = 400
.MoveWhenInTheWay = True
.TipOfDay = True
.Visible = True
.Animation = msoAnimGreeting
End With



Animation Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproAnimationC"}
{ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproAnimationA"}

"Example":"ofproAnimationX":1}

{ewc HLP95EN.DLL, DYNALINK,
{ewc

HLPO95EN.DLL, DYNALINK, "Specifics":"ofproAnimationS"}

Returns or sets the animation action for the Office Assistant. When this property is applied to the
Assistant object, the Assistant is animated immediately (if the Assistant is visible). When this
property is applied to the Balloon object, the Assistant is animated only while the balloon is

displayed. Read/write Long.

Can be one of the following MsoAnimationType constants:

msoAnimationAppear
msoAnimationBeginSpeaking
msoAnimationCharacterSuccessMajor
msoAnimationCheckingSomething
msoAnimationDisappear
msoAnimationEmptyTrash
msoAnimationGestureDown
msoAnimationGesturelL eft
msoAnimationGestureRight
msoAnimationGestureUp
msoAnimationGetArtsy
msoAnimationGetAttentionMajor
msoAnimationGetAttentionMinor
msoAnimationGetTechy
msoAnimationGetWizardy
msoAnimationGoodbye
msoAnimationGreeting

Remarks

msoAnimationldle
msoAnimationListensToComputer
msoAnimationLookDown
msoAnimationLookDownLeft
msoAnimationLookDownRight
msoAnimationLookLeft
msoAnimationLookRight
msoAnimationLookUp
msoAnimationLookUpLeft
msoAnimationLookUpRight
msoAnimationPrinting
msoAnimationSaving
msoAnimationSearching
msoAnimationSendingMail
msoAnimationThinking
msoAnimationWorkingAtSomething
msoAnimationWritingNotingSomething

Clippit is the default Assistant, and msoAnimationldle is the default animation type for the Assistant.

Depending on the selected Assistant, setting the Animation property may or may not result in any
obvious animation. However, all MsoAnimationType constants are valid for all Assistants.

The following MsoAnimationType constants represent animations that repeat the specified action
until the Assistant is dismissed, or until the Animation property is reset with another animation.

msoAnimationCheckingSomething msoAnimationSearching

msoAnimationGetArtsy
msoAnimationGetTechy
msoAnimationSaving

msoAnimationThinking
msoAnimationWorkingAtSomething
msoAnimationWritingNotingSomething



Animation Property Example

This example displays the Office Assistant in a specific location, and it sets several options before
making the Assistant visible.

With Assistant
.Reduced = True
.Move xLeft:= 400, yTop:= 300
.MoveWhenInTheWay = True
.TipOfDay = True
.Visible = True
.Animation = msoAnimationGreeting
End With



FileName Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproFileNameC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproFileNameX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproFileNameA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproFileNameS"}

Assistant object: Returns or sets the name of the file for the active Office Assistant. Read/write
String.

FileSearch object: Returns or sets the name of the file to look for during a file search. The name of
the file may include the * (asterisk) or ? (question mark) wildcards. Use the question mark wildcard to
match any single character. For example, type gr?y to match both "gray" and "grey." Use the asterisk
wildcard to match any number of characters. For example, type *.txt to find all files that have the .TXT
extension. Read-write String.

Remarks

In Windows, the file name extension for Assistant files is .act, and the files are installed in the
\Program Files\Microsoft Office\Office\Actors folder in Windows 95, in the \Windows\MsApps\Actors
folder in Windows NT, and in the Microsoft:Assistants folder on the Macintosh.

The following file names correspond to the Assistants in Office 97.

Character File name
Office Logo Logo.act
PowerPup Powerpup.act
The Genius Genius.act
Hoverbot Hoverbot.act
Scribble Scribble.act
The Dot Dot.act
Clippit Clippit.act
Mother Nature MNature.act

Will Will.act



FileName Property Example

This example uses the FileName property to customize balloon text for specific Office Assistants. The
variable btext can be used for the value of the Text property in a Print Wizard balloon.

Select Case Assistant.FileName
Case "will.act"

btext = "To Print, or Not to Print. That is the question."
Case "genius.act"

btext = "The sum of the checkboxes equals the document to print."
Case Else

btext = "Choose the document you want to print."
End Select

This example searches for all files located in the My Documents folder that begin with "cmd." The
example displays the name and location of each found file.

Set fs = Application.FileSearch

With fs
.LookIn = "C:\My Documents"
.FileName = "cmd*"
If .Execute > 0 Then
MsgBox "There were " & .FoundFiles.Count & _
" file(s) found."
For i = 1 To .FoundFiles.Count
MsgBox .FoundFiles (i)
Next i
Else
MsgBox "There were no files found."
End If

End With



BalloonType Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproBalloonTypeC"} {ewc HLP95EN.DLL, DYNALINK,

"Example":"ofproBalloonTypeX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproBalloonTypeA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproBalloonTypeS"}

Returns or sets the type of balloon the Office Assistant uses. Can be one of the following
MsoBalloonType constants: msoBalloonTypeButtons, msoBalloonTypeBullets, or
msoBalloonTypeNumbers. When you create a new balloon with the NewBalloon method, this
property is initially set to msoBalloonTypeButtons. Read/write Long.



BalloonType Property Example

This example creates an instruction balloon that explains how to select a printer. The balloon is
modeless, so the user can follow the instructions in the balloon and keep the balloon visible as he or
she works.

Set bln = Assistant.NewBalloon

With bln
.Heading = "Instructions for Choosing a Printer."
.Text = "Click OK when you've chosen a printer.”

.Labels (1) .Text "From the File menu, choose Print.
.Labels (2) .Text = "Click Setup."

.Labels (3) .Text "Select the name of the printer.”
.BalloonType = msoBalloonTypeNumbers

.Mode = msoModeModeless

.Callback = "ProcessPrinter"
.Button = msoButtonSetOK
.Show

End With



Button Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproButtonC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproButtonX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproButtonA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproButtonS"}

Returns or sets the type of button displayed at the bottom of the Office Assistant balloon. When you
create a new balloon with the NewBalloon method, this property is initially set to msoButtonSetOK.
Read/write Long.

Can be one of the following MsoButtonSetType constants:

msoButtonSetAbortRetrylgnore msoButtonSetOkCancel
msoButtonSetBackClose msoButtonSetRetryCancel
msoButtonSetBackNextClose msoButtonSetSearchClose
msoButtonSetBackNextSnooze msoButtonSetTipsOptionsClose
msoButtonSetCancel msoButtonSetYesAlINoCancel
msoButtonSetNextClose msoButtonSetYesNoCancel
msoButtonSetNone msoButtonSetYesNo

msoButtonSetOK



Button Property Example
This example creates a balloon with a heading, text, and three region choices, and then displays it.

With Assistant.NewBalloon

.Heading = "Regional Sales Data"
.Text = "Select a region"
For i = 1 To 3
.CheckBoxes (1) .Text = "Region " & i
Next
.Button = msoButtonSetOkCancel
.Show

End With



Checkboxes Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproCheckboxesC"} {ewc HLP95EN.DLL, DYNALINK,

"Example":"ofproCheckboxesX":1} {ewc HLPO95EN.DLL, DYNALINK, "Applies To":"ofproCheckboxesA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproCheckboxesS"}

Returns the BalloonCheckboxes collection that represents all the check boxes contained in the
specified balloon. Read-only.

For information about returning a single member of a collection, see Returning an Object from a
Collection.



Checkboxes Property Example

This example creates a balloon with a heading, text, and three region choices. When the user selects
a check box and then clicks OK in the balloon, the appropriate procedure is run.

With Assistant.NewBalloon

.Heading = "Regional Sales Data"
.Text = "Select your region"
For i = 1 To 3
.CheckBoxes (1) .Text = "Region " & i
Next
.Button = msoButtonSetOkCancel
.Show

Select Case True
Case .CheckBoxes (1) .Checked

runregionl
Case .CheckBoxes (2) .Checked
runregion?2
Case .CheckBoxes (3) .Checked
runregion3
End Select

End With



Checked Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproCheckedC"} {ewc HLPO95EN.DLL, DYNALINK,

"Example":"ofproCheckedX":1} {ewc HLPO95EN.DLL, DYNALINK, "Applies To":"ofproCheckedA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproCheckedS"}

True if the specified check box in the Office Assistant balloon is selected. Read/write Boolean.



Checked Property Example

This example creates a balloon with a heading, text, and three region choices. When the user selects
a check box and then clicks OK in the balloon, the appropriate procedure is run.

With Assistant.NewBalloon

.Heading = "Regional Sales Data"
.Text = "Select your region"
For i = 1 To 3
.CheckBoxes (i) .Text = "Region " & i
Next
.Button = msoButtonSetOkCancel
.Show

Select Case True
Case .CheckBoxes (1) .Checked

runregionl
Case .CheckBoxes (2) .Checked
runregion?2
Case .CheckBoxes (3) .Checked
runregion3
End Select

End With



FeatureTips Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproFeatureTipsC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproFeatureTipsX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproFeatureTipsA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproFeatureTipsS"}

True if the Office Assistant provides information about using application features more effectively.
Read/write Boolean.
Remarks

The FeatureTips property corresponds to the Using features more effectively check box on the
Options tab in the Assistant dialog box.



FeatureTips Property Example

This example sets the Office Assistant to provide information about using application features more
effectively.

Assistant.FeatureTips = True



GuessHelp Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproGuessHelpC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproGuessHelpX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproGuessHelpA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproGuessHelpS"}

True if the Office Assistant displays a list of relevant Help topics based on the context immediately
before the user clicks the Assistant window or presses F1. Read/write Boolean.
Remarks

The GuessHelp property corresponds to the Guess help topics option under Assistant capabilities
on the Options tab in the Office Assistant dialog box.



GuessHelp Property Example
This example sets the Office Assistant to guess at Help topics.

Assistant.GuessHelp = True



Heading Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproHeadingC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproHeadingX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproHeadingA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproHeadingS"}

Returns or sets the heading that appears in the Office Assistant balloon. Read/write String.

Remarks

You can specify a graphic to display by using the following syntax: {type location sizing_factor}, where
type is bmp (bitmap), wmf (Windows metafile), or pict (Macintosh PICT file); location is the resource id
or the path and file name; and sizing_factor specifies the width of the wmf or pict (omitted for bmp).



Heading Property Example
This example creates a balloon with a heading, text, and three region choices, and then displays it.

With Assistant.NewBalloon
.Button = msoButtonSetOkCancel

.Heading = "Regional Sales Data"
.Text = "Select a region"
For 1 = 1 To 3
.CheckBoxes (1) .Text = "Region " & i
Next
.Show

End With



Help Method

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthHelpC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthHelpX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofmthHelpA"} {ewc HLP95EN.DLL,
DYNALINK, "Specifics":"ofmthHelpS"}

Displays the Office Assistant and the built-in Assistant balloon.
Syntax

expression.Help

expression Required. An expression that returns an Assistant object.



Help Method Example

This example displays the built-in Assistant balloon when the user selects the "l need more
information" checkbox.

Set b = Assistant.NewBalloon

With b
.Heading = "User Information"
.Text = "Select your skill level"
.CheckBoxes (1) .Text = "Beginner."
.CheckBoxes (2) .Text = "Advanced."
.CheckBoxes (3) .Text = "I need more information."
.Show

End With

If b.CheckBoxes (3) .Checked = True Then
Assistant.Help
End If



AssistWithWizards Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproAssistWithWizardsC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproAssistWithWizardsX": 1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproAssistWithWizardsA"}
{ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofproAssistWithWizardsS"}

True if the Office Assistant provides Help information about wizards. Read/write Boolean.

Remarks

The AssistWithWizards property corresponds to the Help with wizards option under Assistant
capabilities on the Options tab in the Office Assistant dialog box.



AssistWithWizards Property Example
This example sets the Office Assistant to provide Help information about wizards.

Assistant.AssistWithWizards = True



HighPriority Tips Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproHighPriority TipsC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproHighPriority TipsX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproHighPriority TipsA"}
{ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofproHighPriority TipsS"}

True if the Office Assistant displays high-priority tips. Read/write Boolean.

Remarks

The HighPriorityTips property corresponds to the Only show high priority tips option under Other
tip options on the Options tab in the Office Assistant dialog box.



HighPriorityTips Property Example
This example sets the Office Assistant to display high-priority tips.
Assistant.HighPriorityTips = True



Icon Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofprolconC"} {ewc HLP95EN.DLL, DYNALINK,

"Example":"ofprolconX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofprolconA"} {ewc HLP95EN.DLL,
DYNALINK, "Specifics":"ofprolconS"}

Returns or sets the type of icon that appears in the upper-left portion of the Office Assistant balloon.
Can be one of the following MsolconType constants: msolconAlert, msolconNone, or msolconTip.
Read/write String.



Icon Property Example

This example creates a balloon with an alert icon that instructs the user to select a printer.

With Assistant.NewBalloon
.Heading = "Select A Printer"
.Text = "You must select a printer before printing."
.Icon = msolIconAlert
.CheckBoxes (1) .Text "Local printer"
.CheckBoxes (2) .Text = "Network printer"
.Show

End With



KeyboardShortcutTips Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproKeyboardShortcutTipsC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproKeyboardShortcutTipsX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies
To":"ofproKeyboardShortcutTipsA"} {ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofproKeyboardShortcutTipsS"}

True if the Office Assistant provides Help information about keyboard shortcuts. Read/write Boolean.

Remarks

The KeyboardShortcutTips property corresponds to the Keyboard shortcuts option under Show
tips about on the Options tab in the Office Assistant dialog box.



KeyboardShortcutTips Property Example
This example sets the Office Assistant to provide Help information about keyboard shortcuts.
Assistant.KeyboardShortcutTips = True



Labels Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproLabelsC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproLabelsX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproLabelsA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproLabelsS"}

Returns a BalloonLabels collection that represents the button labels, number labels, and bullet
labels contained in the specified Office Assistant balloon. Read-only.

For information about returning a single member of a collection, see Returning an Object from a
Collection.



Labels Property Example

This example creates a balloon containing three choices. The variable x is set to the return value of
the Show method, which will be 1, 2 or 3, corresponding to the label the user clicks. In the example, a
simple message box displays the value of the variable x, but you can pass the value to another
procedure, or you can use the value in a Select Case statement.

Set b = Assistant.NewBalloon

With b
.Heading = "This is my heading"
.Text = "Select one of these things:"
.Labels (1) .Text = "Choice One"
.Labels (2) .Text = "Choice Two"
.Labels (3) .Text = "Choice Three"
X = .Show

End With

MsgBox x



BalloonError Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproBalloonErrorC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproBalloonErrorX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproBalloonErrorA"}
HLP95EN.DLL, DYNALINK, "Specifics":"ofproBalloonErrorS"}

Returns a value that indicates the last recorded balloon error. Read-only String.
Can be one of the following MsoBalloonErrorType constants.

Constant Description

msoBalloonErrorBadPictureRef The balloon contains a bitmap that
couldn't be displayed because the file
doesn't exist or because the bitmap
isn't a valid .BMP or .WMF file (or
PICT file on the Macintosh).

msoBalloonErrorBadReference The balloon contains an unrecognized
or unsupported reference.

msoBalloonErrorButtonlessModal  The balloon you attempted to display
is modal, but it contains no buttons.
The balloon won't be shown because
it cannot be dismissed.

msoBalloonErrorButtonModeless The balloon you attempted to display
is modeless, contains no buttons, and
has no procedure assigned to the
Callback property. The balloon won't
be shown because a procedure is
required to evaluate the button clicked

in the balloon.
msoBalloonErrorNone The property succeeded in displaying

the balloon; no error was

encountered.
msoBalloonErrorBadCharacter The balloon contains an ASCII control

character other than CR or LF and
greater than 32.

msoBalloonErrorOutOfMemory The balloon won't appear because
there is insufficient memory.

msoBalloonErrorTooBig The balloon is too big to appear on
the screen.

msoBalloonErrorOther The balloon won't appear because

some other error occurred, such as
another modal balloon is already
active.

{ewc



BalloonError Property Example

This example creates a balloon that generates an error. The error is caused because the balloon is
created without a way to dismiss it: the button type was set to msoButtonSetNone and the default
balloon mode is msoModeModal, resulting in a buttonless balloon. Note that there's no way to
dismiss a buttonless modal balloon.

With Application.Assistant
With .NewBalloon

.Heading = "This will never show."
.Text = "Imagine a balloon here."
.Button = msoButtonSetNone
. Show

End With

.Visible = True

If .BalloonError = msoBalloonErrorButtonlessModal Then
MsgBox "You need a button to dismiss the balloon."

End If

End With



Mode Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproModeC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproModeX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproModeA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproModeS"}

Returns or sets the type of balloon displayed. Can be one of the following MsoModeType constants:
msoModeAutoDown, msoModeModal, or msoModeModeless. When you create a new balloon
with the NewBalloon method, this property is initially set to msoModeModal. Read/write Long.

Remarks

If the Mode property for a balloon is set to msoModeModeless, the user can work in the application
while the balloon is visible. If the property is set to msoModeModal, the user must dismiss the
balloon before he or she can return to working in the application. If the property is set to
msoModeAutoDown, the balloon is instantly dismissed when the user clicks anywhere on the
screen.

If the Mode property for a balloon is set to msoModeModeless, a value for the Callback property is
required. The Close method can only be used if the property is set to msoModeModeless.



Mode Property Example

This example creates a balloon with an alert icon that instructs the user to select a printer. Because
the balloon is modeless, the user has access to printer commands while the balloon is visible.

With Assistant.NewBalloon
.Heading = "Select A Printer"
.Text = "You must select a printer before printing."
.Icon = msolIconAlert
.CheckBoxes (1) .Text = "Local printer"
.CheckBoxes (2) .Text = "Network printer"
.Mode = msoModeModeless
.Callback = "ProcessPrinter"
.Show
End With



MouseTips Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproMouseTipsC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproMouseTipsX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproMouseTipsA"} {ewc

HLPO5EN.DLL, DYNALINK, "Specifics":"ofproMouseTipsS"}

True if the Office Assistant provides suggestions for using the mouse more effectively. Read/write.
Boolean.

Remarks

The MouseTips property corresponds to the Using the mouse more effectively option under Show
tips about on the Options tab in the Office Assistant dialog box.



MouseTips Property Example
This example sets the Office Assistant to provide suggestions for using the mouse more effectively.

Assistant.MouseTips = True



Assistant Object

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofobjCommandBarC "} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofobjAssistantX":1} {ewc HLP95EN.DLL, DYNALINK, "Properties":"ofobjAssistantP "} {ewc
HLP95EN.DLL, DYNALINK, "Methods":"ofobjAssistantM "} {ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofobjAssistantS
"

|Assistant |

|Ba“uun |

|Ba“nnnEhecanues[Ba“nunEhecanu] |

L

|BalloonLabels [BalloonLabel) |
Represents the Microsoft Office Assistant.

Using the Assistant Object

Use the Assistant property to return the Assistant object. There's no collection for the Assistant
object; only one Assistant object can be active at a time. Use the Visible property to display the
Assistant. -

Remarks

The default Assistant is Clippit. To select a different Assistant programatically, use the FileName
property.

The following example displays a previously selected Assistant and animates it with the associated
sound. If your computer doesn't have a sound card installed, this example won't generate an error,
but the sound won't be heard.

With Assistant

.Visible = True

.Sounds = True

.Animation = msoAnimationBeginSpeaking
End With



Balloon Object

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofobjCommandBarC "} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofobjBalloonX":1} {ewc HLP95EN.DLL, DYNALINK, "Properties":"ofobjBalloonP "} {ewc
HLP95EN.DLL, DYNALINK, "Methods":"ofobjBalloonM "} {ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofobjBalloonS
"

|Assistant |

|Ba“uun |

|Ba“nnnEhecanues[Ba“nunEhecanu] |

L

|BalloonLabels [BalloonLabel) |

Represents the balloon in which the Office Assistant displays headings and text information. A balloon
can contain controls such as check boxes and labels.

Using the Balloon Object

Use the NewBalloon property to return a Balloon object. There's no collection for the Balloon
object; only one balloon can be visible at a time. However, it's possible to define several balloons and
call any one of them when needed. For more information, see "Defining and Reusing Balloons" later
in this topic.

Use the Show method to make the specified balloon visible. Use the Callback property to run
procedures based on selections from modeless balloons (balloons that remain visible while a user
works in the application). Use the Close method to close modeless balloons.

The following example creates a balloon that contains tips for saving entered data.

With Assistant.NewBalloon
.BalloonType = msoBalloonTypeBullets
.Icon = msoIconTip
.Button = msoButtonSetOkCancel

.Heading = "Tips for Saving Information."
.Labels (1) .Text = "Save your work often."
.Labels (2) .Text = "Install a surge protector."
.Labels (3) .Text = "Exit your application properly."
.Show

End With

Defining and Reusing Balloons

You can reuse balloons by assigning them to object variables and calling them when needed
throughout your procedure. This example defines balloonl, balloon2, and balloon3 as separate
balloons, and it displays the balloons at various points in the procedure.

Set balloonl = Assistant.NewBalloon
balloonl.Heading = "First balloon"

Set balloon2 = Assistant.NewBalloon
balloon2.Heading = "Second balloon"



Set balloon3 = Assistant.NewBalloon
balloon3.Heading = "Third balloon"
balloonl.Show

balloon3.Show

balloon2.Show

You can also combine balloon object variables in an array and index into the array.



BalloonCheckboxes Collection Object

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofobjBalloonCheckboxesC "} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofobjBalloonCheckboxesX":1} {ewc HLP95EN.DLL, DYNALINK, "Properties":"ofobjBalloonCheckboxesP "}
{ewc HLP95EN.DLL, DYNALINK, "Methods":"ofobjBalloonCheckboxesM "} {ewc HLP95EN.DLL, DYNALINK,
"Specifics":"ofobjBalloonCheckboxesS "}

| Assziztant |

L

|Ba“uun |

|Ba“nnnEhecanues[Ba“nunEhecanu] |

L

|BalloonLabels [BalloonLabel) |

A collection of BalloonCheckbox objects that represent all the check boxes in the Office Assistant
balloon.

Using the BalloonCheckboxes Collection
Use the Checkboxes property to return the BalloonCheckboxes collection.

Use Checkboxes(index), where index is a number from 1 through 5, to return a single
BalloonCheckbox object. There can be up to five check boxes in one balloon; each check box
appears when a value is assigned to its Text property.

The following example writes the checkbox text of all visible checkboxes, in an existing balloon, to the
debug window.

For Each box In .CheckBoxes

If box.Text <> "" Then
Debug.Print box.Text
End If
Next

You cannot add check boxes to or remove check boxes from the BalloonCheckboxes collection.

Remarks

Balloon check boxes display the user's choices until he or she dismisses the balloon. Balloon labels
record the user's choice as soon as he or she clicks the button beside the label.



BalloonCheckbox Object

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofobjBalloonCheckboxC "} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofobjBalloonCheckboxX":1} {ewc HLP95EN.DLL, DYNALINK, "Properties":"ofobjBalloonCheckboxP "}
{ewc HLP95EN.DLL, DYNALINK, "Methods":"ofobjBalloonCheckboxM "} {ewc HLP95EN.DLL, DYNALINK,

"Specifics":"ofobjBalloonCheckboxS "}

| Assziztant |

Represents a check box in the Office Assistant balloon. The BalloonCheckbox object is a member of
the BalloonCheckboxes collection.

Using the BalloonCheckbox Object

Use Checkboxes(index), where index is a number from 1 through 5, to return a single
BalloonCheckbox object. There can be up to five check boxes in one balloon; each check box
appears when a value is assigned to its Text property.

The following example creates a balloon with a heading, text, and three region choices. When the
user selects a check box and then clicks OK, the appropriate procedure is run.

With Assistant.NewBalloon

.Heading = "Regional Sales Data"
.Text = "Select your region"
For i = 1 To 3
.CheckBoxes (i) .Text = "Region " & i
Next
.Button = msoButtonSetOkCancel
.Show

Select Case True
Case .CheckBoxes (1) .Checked

runregionl
Case .CheckBoxes (2) .Checked
runregion?
Case .CheckBoxes (3) .Checked
runregion3
End Select
End With
Remarks

Balloon check boxes display the user's choices until the user dismisses the balloon. Balloon labels
record the user's choice as soon as the user clicks the button beside the label.



BalloonLabels Collection Object

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofobjBalloonLabelsC "} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofobjBalloonLabelsX":1} {ewc HLP95EN.DLL, DYNALINK, "Properties":"ofobjBalloonLabelsP "}
{ewc HLP95EN.DLL, DYNALINK, "Methods":"ofobjBalloonLabelsM "} {ewc HLP95EN.DLL, DYNALINK,

"Specifics":"ofobjBalloonLabelsS "}

A collection of BalloonLabel objects that represent all the labels in the Office Assistant balloon.

Using the BalloonLabels Collection
Use the Labels property to return the BalloonLabels collection.

Use Labels(index), where index is a number from 1 through 5, to return a BalloonLabel object.
There can be up to five labels in one balloon; each label appears when a value is assisgned to its
Text property.

The following example creates a balloon containing three choices. The variable x is set to the return
value of the Show method, which will be 1, 2, or 3, corresponding to the label the user clicks. The
example displays the value of the variable x, but you can pass the value to another procedure, or you
can use the value in a Select Case statement.

Set b = Assistant.NewBalloon

With b
.Heading = "This is my heading"
.Text = "Select one of these things:"
.Labels (1) .Text = "Choice One"
.Labels (2) .Text = "Choice Two"
.Labels (3) .Text = "Choice Three"
x = .Show

End With

MsgBox x

Remarks

Balloon check boxes display the user's choices until the user dismisses the balloon. Balloon labels
record the user's choice as soon as the user clicks the button beside the label.



BalloonLabel Object

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofobjBalloonLabelC "} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofobjBalloonLabelX":1} {ewc HLP95EN.DLL, DYNALINK, "Properties":"ofobjBalloonLabelP "} {ewc
HLP95EN.DLL, DYNALINK, "Methods":"ofobjBalloonLabelM "} {ewc HLP95EN.DLL, DYNALINK,

"Specifics":"ofobjBalloonLabelS "}

Represents a label in the Office Assistant balloon. The BalloonLabel object is a member of the
BalloonL abels collection.
Using the BalloonLabel Object

Use Labels(index), where index is a number from 1 through 5, to return a BalloonLabel object.
There can be up to five labels on one balloon; each label appears when a value is assisgned to its
Text property.

The following example creates a balloon that asks the user to click the label corresponding to his or
her age.

With Assistant.NewBalloon

.Heading = "Check Your Age Group."
.Labels (1) .Text = "Under 30."
.Labels (2) .Text = "Over 30."
.Labels (3) .Text = "None of your business."
.Text = "Which of the following " _
& .Labels.Count & " choices apply to you?"

.Show

End With

Remarks

Balloon check boxes display the user's choices until he or she dismisses the balloon. Balloon labels
record the user's choice as soon as he or she clicks the button beside the label.



Add Method

Adds an object to a collection. Select one of the following collections to see a detailed description of
the Add method for that collection.

CommandBarControls

CommandBars

DocumentProperties

PropertyTests




Add Method (CommandBarControls Collection)

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthAddCommandBarControlsObjC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthAddCommandBarControlsObjX":1} {ewc HLPO95EN.DLL, DYNALINK, "Applies
To":"ofmthAddCommandBarControlsObjA"} {ewc HLP95EN.DLL, DYNALINK,

"Specifics":"ofmthAddCommandBarControlsObjS"}

Creates a new command bar control and adds it to the collection of controls on the specified

command bar. Returns a CommandBarButton, CommandBarComboBox, or CommandBarPopup
object.

Syntax
expression.Add(Type, Id, Parameter, Before, Temporary)

expression Required. An expression that returns a CommandBarControls object.

Type Optional Variant. The type of control to be added to the specified command bar. Can be one
of the following MsoControlType constants: msoControlButton, msoControlEdit,
msoControlDropdown, msoControlComboBox, or msoControlPopup.

Id  Optional Variant. An integer that specifies a built-in control. If the value of this argument is 1, or if
this argument is omitted, a blank custom control of the specified type will be added to the
command bar.

Parameter Optional Variant. For built-in controls, this argument is used by the container
application to run the command. For custom controls, you can use this argument to send
information to Visual Basic procedures, or you can use it to store information about the control
(similar to a second Tag property value).

Before Optional Variant. A number that indicates the position of the new control on the command
bar. The new control will be inserted before the control at this position. If this argument is omitted,
the control is added at the end of the specified command bar.

Temporary Optional Variant. True to make the new control temporary. Temporary controls are
automatically deleted when the container application is closed. The default value is False.



Add Method (CommandBarControls Collection) Example

This example adds a button control with a charting face to the command bar named "Custom," and
then it assigns the control the procedure named "Analyze."

Set custBar = CommandBars ("Custom")

custBar.Visible = True

Set graphBtn = custBar.Controls.Add (Type:=msoControlButton)
graphBtn.FacelId = 17

graphBtn.OnAction = "Analyze"



Add Method (CommandBars Collection)

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthAddCommandBarsObjC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthAddCommandBarsObjX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies
To":"ofmthAddCommandBarsObjA"} {ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofmthAddCommandBarsObjS"}

Creates a new command bar and adds it to the collection of command bars. Returns a CommandBar
object.

Syntax
expression.Add(Name, Position, MenuBar, Temporary)

expression Required. An expression that returns a CommandBars object.

Name Optional Variant. The name of the new command bar. If this argument is omitted, Word
assigns a default name to the command bar (such as "Custom 1").

Position Optional Variant. The position of the new command bar. Can be one of the following
MsoBarPosition constants.

Constant Description

msoBarLeft, msoBarTop, Indicate the left, top, right, and

msoBarRight, msoBarBottom bottom coordinates of the new
command bar

msoBarFloating Indicates that the new command bar
won't be docked

msoBarPopup Indicates that the new command bar
will be a shortcut menu

msoBarMenuBar Indicates that the new command bar

will replace the system menu bar on
the Macintosh

MenuBar Optional Variant. True to replace the active menu bar with the new command bar. The
default value is False.

Temporary Optional Variant. True to make the new command bar temporary. Temporary
command bars are deleted when the container application is closed. The default value is False.



Add Method (CommandBars Collection) Example

This example adds a top-level command bar named "Custom" that won't be saved when the session
ends. The example also adds a built-in spelling-checker button to the command bar.

Set mybar = CommandBars _
.Add (Name:="Custom", Position:=msoBarTop,
Temporary:=True)

With mybar
.Controls.Add Type:=msoControlButton, Id:=2
.Visible = True

End With



Add Method (DocumentProperties Collection)

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthAddDocumentPropertiesObjC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthAddDocumentPropertiesObjX":1} {ewc HLPO95EN.DLL, DYNALINK, "Applies
To":"ofmthAddDocumentPropertiesObjA"} {ewc HLP95EN.DLL, DYNALINK,

"Specifics":"ofmthAddDocumentPropertiesObjS"}

Creates a new custom document property. You can use this method only with the collection of custom
document properties.

Syntax
expression.Add(Name, LinkToContent, Type, Value, LinkSource)

expression Required. The custom DocumentProperties object.
Name Required String. The name of the property.

LinkToContent Required Boolean. Specifies whether the property is linked to the contents of the
container document. If this argument is True, the LinkSource argument is required; if it's False,
the value argument is required.

Type Required Long. The data type of the property. Can be one of the following
MsoDocProperties constants: msoPropertyTypeBoolean, msoPropertyTypeDate,
msoPropertyTypeFloat, msoPropertyTypeNumber, or msoPropertyTypeString.

Value Optional Variant. The value of the property if it's not linked to the contents of the container
document. The value is converted to match the data type specified by the type argument, if
possible; otherwise, an error occurs. If LinkToContent is True, the Value argument is ignored and
the new document property has a default value until linked property values are updated by the
container application (usually when the document is saved).

LinkSource Optional Boolean. Ignored if LinkToContent is False. The source of the linked
property. The container application determines what types of source linking you can use.



Add Method (DocumentProperties Collection) Example

This example adds a new custom document property and names it "Complete." You must pass the
custom DocumentProperties collection to the procedure.

Sub AddCustomProperty(dp As DocumentProperties)
dp.Add name:="Complete", linkToContent:=False,
type:=msoPropertyTypeBoolean, value:=False

End Sub



Add Method (PropertyTests Collection)

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthAddProperty TestsObjC"}  {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthAddProperty TestsObjX": 1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofmthAddProperty TestsObjA"}

Adds a PropertyTest object to the PropertyTests collection.

Syntax
expression.Add(Name, Condition, Value, SecondValue, Connector)

expression An expression that returns a PropertyTests object.

Name Required String. The name of the property criterion. The name corresponds to a value in
the Property box in the Advanced Find dialog box.

Condition Required Variant. The condition of the search criteria. Can be one of the following
MsoCondition constants:

msoConditionAnyNumberBetween msoConditionInTheNext
msoConditionAnytime msoConditionlsExactly
msoConditionAnytimeBetween msoConditionlsNo
msoConditionAtLeast msoConditionlsNot
msoConditionAtMost msoConditionlsYes
msoConditionBeginsWith msoConditionLastMonth
msoConditionDoesNotEqual msoConditionLastWeek
msoConditionEndsWith msoConditionLessThan
msoConditionEquals msoConditionMoreThan
msoConditionFileTypeAllFiles msoConditionNextMonth
msoConditionFileTypeBinders msoConditionNextWeek
msoConditionFileTypeDatabases msoConditionOn
msoConditionFileTypeExcelWorkbooks msoConditionOnorAfter
msoConditionFileTypeOfficeFiles msoConditionOnorBefore
msoConditionFileTypePowerPointPresentations msoConditionThisMonth
msoConditionFileTypeTemplates msoConditionThisWeek
msoConditionFileTypeWordDocuments msoConditionToday
msoConditionincludesNearEachOther msoConditionTomorrow
msoConditionincludesPhrase msoConditionYesterday

msoConditionInTheLast

Value Optional Variant. The value of the search criterion to test for.

SecondValue Optional Variant. An upper value for the search range. You can use this argument
only if Condition is msoConditionAnyTimeBetween or msoConditionAnyNumberBetween.

Connector Optional Variant. Specifies the way two search criteria are combined. Can be either of
the following msoConnector constants: msoConnectorAnd or msoConnectorOr.



Add Method (PropertyTests Collection) Example

This example adds two property tests to the search criteria. The first test is that the found files must

be Word documents, and the second test is that the found files must have been modified between
January 1, 1996 and June 30, 1996.

Set fs = Application.FileSearch
fs.NewSearch
With fs.PropertyTests
.Add Name:="Files of Type", _
Condition:=msoConditionFileTypeWordDocuments,
Connector:=msoConnectorOr
.Add Name:="Last Modified",
Condition:=msoConditionAnytimeBetween,
Value:="1/1/96", SecondValue:="6/30/96",
Connector:=msoConnectorAnd
End With



Copy Method

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthCopyC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthCopyX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofmthCopyA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofmthCopyS"}

Copies the specified command bar control to an existing command bar.

Syntax
expression.Copy(Bar, Before)

expression  Required. An expression that returns a CommandBarControl, CommandBarButton,
CommandBarPopup, or CommandBarComboBox object.

Bar Optional Variant. A CommandBar object that represents the destination command bar. If this
argument is omitted, the control is copied to the same command bar (the command bar it's already
on).

Before Optional Variant. A number that indicates the position for the new control on the specified
command bar. The new control will be inserted before the control at this position. If this argument is
omitted, the control is copied to the end of the command bar.



Copy Method Example

This example copies the first control from the command bar named "Standard" to the command bar
named "Custom" and positions it as the first control there too. The example assigns a new parameter
to the control and sets the focus to the new button.

Set myCustomBar = CommandBars ("Custom")
Set myControl = CommandBars ("Standard") .Controls (1)
With myControl
.Copy Bar:=myCustomBar, Before:=1
.Parameter = "2"
.SetFocus
End With



Count Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproCountC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproCountX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproCountA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproCountS"}

Returns the number of items in the specified collection. Read-only Long.

Remarks

For the CommandBars collection, the count includes only menu bars, toolbars, and shortcut menus.
Menus and submenus aren't included.



Count Property Example

This example uses the Count property to display the number of command bars in the collection.

MsgBox "There are " & CommandBars.Count & " bars in your collection."

This example uses the Count property to display the number of check boxes in the Office Assistant
balloon.

With Assistant.NewBalloon

.CheckBoxes (1) .Text = "First Choice"
.CheckBoxes (2) .Text = "Second Choice"
.Text = "You have the following " _
& .CheckBoxes.Count & " choices."
.Show

End With

This example uses the Count property to display the number of labels in the Office Assistant balloon.
With Assistant.NewBalloon

.Heading = "Check Your Age Group."
.Labels (1) .Text = "20 to 29."
.Labels (2) .Text = "30 to 39."
.Labels (3) .Text = "40 or over"
.Text = "Which of the following " _
& .Labels.Count & " choices apply to you?"
.Show

End With

This example displays the number of document properties in the DocumentProperties collection that
was passed to the procedure.

Sub CountDocumentProperties (dp As DocumentProperties)
MsgBox "There are " & dp.Count & " properties in the collection.”
End Sub



Delete Method

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthDeleteC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthDeleteX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofmthDeleteA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofmthDeleteS"}

Deletes the specified object from the collection it's contained in.

Syntax 1

expression.Delete

Syntax 2
expression.Delete(Temporary)
Syntax 3

expression.Delete(BstrQueryName)

expression Required. An expression that returns a CommandBar or DocumentProperty object
(Syntax 1), a CommandBarControl object (Syntax 2), or a FileFind object (Syntax 3).

Temporary Optional Variant. True to delete the control for the current session. The application will
display the control again in the next session.

BstrQueryName Required String. A string containing up to 31 characters that indicates the name
of the saved search criterion to be deleted.

Remarks

You cannot delete a built-in document property.



Delete Method Example

This example deletes all custom command bars that aren't visible.

foundFlag = False
delBars = 0
For Each bar In CommandBars
If (bar.BuiltIn = False) And _
(bar.Visible = False) Then
bar.Delete
foundFlag = True
delBars = delBars + 1
End If
Next
If Not foundFlag Then
MsgBox "No command bars have been deleted."”
Else
MsgBox delBars & " custom bar(s) deleted."
End If

This example deletes a custom document property. You must pass a DocumentProperty object to
the procedure.

Sub DeleteCustomDocumentProperty (dp As DocumentProperty)
dp.Delete
End Sub



Execute Method

Runs a procedure associated with a command bar control or begins searching for files. Select one of
the following objects to see a detailed description of the Execute method for that object.
CommandBarButton

CommandBarControl

CommandBarPopup

CommandBarComboBox

FileSearch

FileFind




Execute Method (Command Bar Controls)

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthExecuteCommandBarControlObjC"} {ewc HLP95EN.DLL,
DYNALINK, "Example":"ofmthExecuteCommandBarControlObjX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies
To":"ofmthExecuteCommandBarControlObjA"} {ewc HLPO5EN.DLL, DYNALINK,

"Specifics":"ofmthExecuteCommandBarControlObjS"}

Runs the macro or built-in command assigned to the specified command bar control. For custom
controls, use the OnAction property to specify the macro to run.

Syntax
expression.Execute

expression Required. An expression that returns a CommandBarControl, CommandBarButton,
CommandBarPopup, or CommandBarComboBox object.



Execute Method (Command Bar Controls) Example

This example checks the value of the combo box control on the custom command bar named "My
Command Bar." If the value is "First,"” the example runs the macro specified by the OnAction property
of the command bar control.

Set mycontrol = CommandBars ("My Custom Bar") .Controls (1)
With mycontrol
If .List(.ListIndex) = "First" Then
mycontrol.Execute
End If

End With



Execute Method (FileSearch and FileFind Objects)

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthExecuteFileSearchObjC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthExecuteFileSearchObjX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies
To":"ofmthExecuteFileSearchObjA"} {ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofmthExecuteFileSearchObjS"}

FileSearch object: Begins the seach for the specified files.

FileFind object: Begins the search for the specified files and updates the FindFileResults collection.
Macintosh only.

Syntax 1

expression.Execute(SortBy, SortOrder, AlwaysAccurate)

Syntax 2

expression.Execute

expression Required. An expression that returns a FileSearch object (Syntax 1) or a FileFind
object (Syntax 2).

SortBy Optional Variant. The method used to sort the returned files. Can be one of the following
MsoSortBy constants: msoSortbyFileName, msoSortbyFileType, msoSortbyLastModified, or
msoSortbySize.

SortOrder Optional Variant. The order in which the returned files are to be sorted. Can be either of
the following MsoSortOrder constants: msoSortOrderAscending or msoSortOrderDescending.

AlwaysAccurate Optional Boolean. True to have the file search include files that have been
added, modified, or deleted since the file index was last updated. The default value is True.



Execute Method (FileSearch and FileFind Objects) Example

This example searches for all files that begin with "ecmd" in the My Documents folder and displays the
location and name of each file that's found. The example sorts the list of returned files in ascending
alphabetic order, by file name.

Set fs = Application.FileSearch

With fs
.LookIn = "C:\My Documents"
.FileName = "cmd*"

If .Execute(SortBy:=msoSortbyFileName,
SortOrder:=msoSortOrderAscending) > 0 Then
MsgBox "There were " & .FoundFiles.Count &
" file(s) found."
For 1 = 1 To .FoundFiles.Count
MsgBox .FoundFiles (i)
Next i
Else
MsgBox "There were no files found."
End If
End With



SetFocus Method

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofmthSetFocusC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofmthSetFocusX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofmthSetFocusA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofmthSetFocusS"}

Moves the keyboard focus to the specified command bar control so that it can receive keyboard input.
The kind of keyboard input you can direct to the control depends on what type of control it is.

Note If the control is disabled or isn't visible from the current state, this method will fail.

Syntax
expression.SetFocus

expression Required. An expression that returns a CommandBarControl, CommandBarButton,
CommandBarPopup, or CommandBarComboBox object.



SetFocus Method Example

This example copies the fourth control from the My Custom Bar custom command bar and pastes it
onto the same command bar as the first control. The example also assigns a new parameter to the
control and sets the focus to the new button.

Set mycontrol = CommandBars ("My Custom Bar")
.Controls (4)
With mycontrol
.Copy Before:=1
.Parameter = "2"
.SetFocus
End With



Text Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproTextC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproTextX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproTextA"} {ewc HLPO5EN.DLL,
DYNALINK, "Specifics":"ofproTextS"}

CommandBarComboBox object: Returns or sets the text in the display or edit portion of the
command bar combo box control. Read/write String.

BalloonLabel or BalloonCheckbox object: Returns or sets the text displayed next to the specified
check box or label in the Office Assistant balloon. Read/write String.

Balloon object: Returns or sets the text displayed after the heading but before the labels or check
boxes in the Office Assistant balloon. Read/write String.

FileFind object: Returns or sets the string to look for, up to 80 characters, in a the body of a
document during a file search. Macintosh only. Read-write String.

Remarks

For the Balloon, BalloonLabel, and BalloonCheckbox objects, you can specify a graphic to display
by using the following syntax: {type location sizing_factor}, where type is bmp (bitmap), wmf
(Windows metafile), or pict (Macintosh PICT file); location is the resource id or the path and file name;
and sizing_factor specifies the width of the wmf or pict (omitted for bmp).



Text Property Example

This example checks the number of items in the combo box control on the command bar named
"Custom." If there are more than three items in the list, the example clears the list and adds a new
first item to it. The new default item for this control is "Floyd."

Set myBar = CommandBars ("Custom")
Set myControl = myBar.Controls(2)
With myControl

If .ListCount > 3 Then

.Clear
.AddItem "Floyd", 1
.Text = "Floyd"

End If

End With

This example creates a new Office Assistant balloon with a heading, text, and three region choices.
The example uses the Text property to provide a label for each check box.

With Assistant.NewBalloon

.Heading = "Regional Sales Data"
.Text = "Select a region"
For 1 = 1 To 3
.CheckBoxes (1) .Text = "Region " & 1
Next
.Show
End With

This example creates a new Office Assistant balloon with a heading, text, and three region choices.
The example uses the Text property to provide balloon-related instructions to the user.

With Assistant.NewBalloon

.Heading = "Regional Sales Data"
.Text = "Select a region"
For 1 = 1 To 3
.CheckBoxes (i) .Text = "Region " & 1
Next
.Show

End With



Top Property
{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproTopC"} {ewc HLP95EN.DLL, DYNALINK, "Example":"ofproTopX":1}
{ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproTopA"} {ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofproTopS"}

CommandBar or CommandBarControl object: Returns or sets the distance (in pixels) from the top
edge of the specified command bar or command bar control to the top edge of the screen. For docked
command bars, this property returns or sets the distance from the command bar to the top of the
docking area. Read/write Long for CommandBar, read-only Long for CommandBarControl.

Assistant object: Sets or returns the vertical position of the Office Assistant window (in points),
relative to the screen. Read/write Integer.



Top Property Example
This example positions the upper-left corner of the floating command bar named "Custom" 140 pixels
from the left edge of the screen and 100 pixels from the top of the screen.

Set myBar = CommandBars ("Custom")
myBar.Position = msoBarFloating

With myBar
.Left = 140
.Top = 100

End With

This example moves the Office Assistant to the specified coordinate.
Assistant.Top = 500



HelpContextld Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproHelpContextldC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproHelpContextldX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproHelpContextldA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproHelpContextldS"}

Returns or sets the Help context ID number for the Help topic attached to the command bar control.
Read/write Long.

Remarks

To use this property, you must also set the HelpFile property.



HelpContextld Property Example

This example adds a custom report manager button to the File menu and specifies a Help topic to be
displayed as that button's context-sensitive Help.

Set fileMenu = CommandBars _
.FindControl (Type:=msoControlPopup, Id:=filelD)
Set fileMenuDropdown = fileMenu.CommandBar
Set newButton = fileMenuDropdown.Controls _
.Add (Type:=msoControlButton, Before:=3)
With newButton

.Caption = "Open Report"

.DescriptionText = "Opens a quarterly report form"
.OnAction = "ReportManager"

.HelpFile = "C:\corphelp\custom.hlp"

.HelpContextID = 47
End With



HelpFile Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproHelpFileC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproHelpFileX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproHelpFileA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproHelpFileS"}

Returns or sets the Help file name for the Help topic attached to the command bar control. Read/write
String.

Remarks

To use this property, you must also set the HelpContextID property.



HelpFile Property Example

This example adds a custom report manager button to the File menu and specifies a Help topic to be
displayed as that button's context-sensitive Help.

Set fileMenu = CommandBars _
.FindControl (Type:=msoControlPopup, Id:=fileld)
Set fileMenuDropdown = fileMenu.CommandBar
Set newbutton = fileMenuDropdown.Controls _
.Add (Type:=msoControlButton, Id:=customId, Before:=3)
With newButton

.Caption = "Open Report"

.DescriptionText = "Opens a quarterly report form"
.OnAction = "ReportManager"

.HelpFile = "C:\corphelp\custom.hlp"

.HelpContextID = 47
End With



LargeButtons Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproLargeButtonsC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproLargeButtonsX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproLargeButtonsA"}
{ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofproLargeButtonsS"}

True if large toolbar buttons are displayed. Read/write Boolean.



LargeButtons Property Example

This example displays large toolbar buttons and ScreenTips on all command bars if the main menu
bar that's active is named "Custom."

Set allBars = CommandBars
If allBars.ActiveMenuBar.Name = "Custom" Then
allBars.LargeButtons = True

allBars.ShowToolTips = True
End If



List Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproListC"} {ewc HLP95EN.DLL, DYNALINK, "Example":"ofproListX":1}
{ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproListA"} {ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofproListS"}

Returns or sets the value of a list item in the command bar combo box control. Read/write String.

Note This property is read-only for built-in combo box controls.

Syntax
expression.List(Index)

expression  Required. An expression that returns a CommandBarComboBox object.
Index Required Long. The list item to be set.



List Property Example

This example checks the value of the fourth list item in the combo box control named "Vegetables" on
the command bar named "Custom." If the value is "Tomato," the code specified by the OnAction
property of the command bar control is run.

Set myBar = CommandBars ("Custom")
Set myControl = myBar.Controls ("Vegetables")
If myControl.List(4) = "Tomatoes" Then myControl.Execute



ListCount Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproListCountC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproListCountX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproListCountA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproListCountS"}

Returns the number of list items in the specified command bar combo box control. Read-only Long.




ListCount Property Example

This example checks the number of items in the combo box control on the command bar named
"Custom." If there are more than three items in the list, the list is cleared and a new first item is added
and displayed as the default for the combo box control.

Set myBar = CommandBars ("Custom")
Set myControl = myBar.Controls(2)
With myControl
If .ListCount > 3 Then
.Clear
.AddItem Text:="Floyd", Index:=1
.ListIndex = 1
End If
End With



ListHeaderCount Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproListHeaderCountC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproListHeaderCountX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproListHeaderCountA"}
{ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofproListHeaderCountS"}

Returns or sets the number of list items in the command bar combo box control that appear above the
separator line. Read/write Long.

Note This property is read-only for built-in combo box controls.

Remarks

A ListHeaderCount property value of — 1 indicates that there's no separator line in the combo box
control.



ListHeaderCount Property Example

The following example adds a combo box control to the command bar named "Custom," and then it
adds two items to the combo box list. The example also sets the number of line items, the width of the
combo box, and an empty default for the combo box.

Set myBar = CommandBars ("Custom")
Set myControl = myBar.Controls.Add (Type:=msoControlComboBox)
With myControl
.AddItem Text:="First Item", Index:=1
.AddItem Text:="Second Item", Index:=2
.DropDownLines = 3
.DropDownWidth = 75
.ListHeaderCount = 1
End With



Listindex Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproListindexC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproListindexX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproListindexA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproListindexS"}

Returns or sets the index number of the selected item in the list portion of the command bar combo
box control.. If nothing is selected in the list, this property returns zero.Read/write Long.

Note This property fails when applied to controls other than list controls.

Remarks

Setting the ListIndex property causes the specified control to select the given item and execute the
appropriate action in the application.



Listindex Property Example

This example runs an existing procedure, based on the selection in the combo box. The text in the
combo box can be anything, because the example uses either the Listindex property or the index
number of the text entry to determine which procedure to run.

With myControl
Select Case .ListIndex
Case 1
chartcourse
Case 2
displaygraph
Case Else
MsgBox "invalid choice"
End Select
End With



NameLocal Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproNameLocalC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproNameLocalX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproNameLocalA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproNameLocalS"}

Returns the name of a built-in command bar as it's displayed in the language version of the container
application, or returns or sets the name of a custom command bar. Read/write String.

Note If you attempt to set this property for a built-in command bar, an error occurs.

Remarks

The local name of a built-in command bar is displayed in the title bar (when the command bar isn't
docked) and in the list of available command bars, wherever that list is displayed in the container
application.

If you change the value of the LocalName property for a custom command bar, the value of Name
changes as well, and vice versa.



NameLocal Property Example

This example displays the name and localized name of the first command bar in the container
application.
With CommandBars (1)

MsgBox "The name of the command bar is " & .Name
MsgBox "The localized name of the command bar is " & .NameLocal

End With



OLEMenuGroup Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproOLEMenuGroupC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproOLEMenuGroupX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproOLEMenuGroupA"}
{ewc HLP95EN.DLL, DYNALINK, "Specifics":"ofproOLEMenuGroupS"}

Returns or sets the menu group that the specified command bar pop-up control belongs to when the
menu groups of the OLE server are merged with the menu groups of an OLE client (that is, when an
object of the container application type is embedded in another application). Can be one of the
following MsoOLEMenuGroup constants: msoOleMenuGroupNone, msoOleMenuGroupfFile,
msoOleMenuGroupEdit, msoOleMenuGroupContainer, msoOleMenuGroupObject,
msoOleMenuGroupWindow, or msoOleMenuGroupHelp. Read/write Long.

Note This property is read-only for built-in controls.

Remarks

This property is intended to allow add-in applications to specify how their command bar controls will
be represented in the Office application. If either the container or the server does not implement
command bars, normal OLE menu merging will occur: the menu bar will be merged, as well as all the
toolbars from the server, and none of the toolbars from the container. This property is relevant only for
pop-up controls on the menu bar because menus are merged on the basis of their menu group
category.

If both of the merging applications implement command bars, command bar controls are merged
according to the OLEUsage property.



OLEMenuGroup Property Example

This example checks the OLEMenuGroup property of a new custom popup control on the active
menu bar, and sets it to msoOLEMenuGroupNone.

Set myControl = ActiveMenuBar.Controls _
.Add (Type:=msoControlPopup, Temporary:=False)
myControl.OLEMenuGroup = msoOLEMenuGroupNone



OLEUsage Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproOLEUsageC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproOLEUsageX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproOLEUsageA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproOLEUsageS"}

Returns or sets the OLE client and OLE server roles in which a command bar control will be used
when two Microsoft Office applications are merged. Can be one of the following
MsoControlOLEUsage constants: msoControlOLEUsageNeither, msoControlOLEUsageServer,
msoControlOLEUsageClient, or msoControlOLEUsageBoth. Read/write Long.

Remarks

This property is intended to allow you to specify how individual add-in applications' command bar
controls will be represented in one Office application when it is merged with another Office
application. If both the client and server implement command bars, the command bar controls are
embedded in the client control by control. Custom controls marked as client-only (or neither client nor
server) are dropped from the server, and controls marked as server-only (or neither server nor client)
are dropped from the client. The remaining controls are merged.

If one of the merging applications isn't an Office application, normal OLE menu merging is used,
which is controlled by the OLEMenuGroup property.




OLEUsage Property Example
This example adds a new button to the command bar named Tools, and sets its OLEUsage
property.

Set myControl = CommandBars ("Tools").Controls
.Add (Type:=msoControlButton, Temporary:=True)
myControl.OLEUsage = msoControlOLEUsageNeither



OnAction Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproOnActionC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproOnActionX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproOnActionA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproOnActionS"}

Returns or sets the name of the Visual Basic macro that will be run when the user clicks or changes
the value of a command bar control. Read/write String.

Note The container application determines whether the value is a valid macro name.



OnAction Property Example

This example adds a command bar control to the command bar named "Custom" and sets the macro
named "MySub" to run whenever the button is clicked.

Set myBar = .CommandBars ("Custom")
Set myControl = myBar.Controls
.Add (Type:=msocontrolButton)
With myControl
.FaceId = 2
.OnAction = "MySub"
End With

myBar.Visible True



Parameter Property

{ewc HLP95EN.DLL, DYNALINK, "See Also":"ofproParameterC"} {ewc HLP95EN.DLL, DYNALINK,
"Example":"ofproParameterX":1} {ewc HLP95EN.DLL, DYNALINK, "Applies To":"ofproParameterA"} {ewc
HLP95EN.DLL, DYNALINK, "Specifics":"ofproParameterS"}

Returns or sets a string that an application can use to execute a command associated with a
command b